
1 
 

 

 

 

 

 

 

 

DesignSpark PCB 

Guidebook 
 

 

 

Written by  

Hsieh Tsung Han (謝宗翰) 

Went Tzu Lin (翁子麟) 

 

 

 

 

 



2 
 

Chapter 1 – DesignSpark PCB: 

Installation and Environment 

Introduction 

 

1-1 DesignSpark PCB Introduction 

 

When we think of design software for circuit design or a printed circuit board (PCB), which 

is "electronic design automation software" (EDA), we might think of EAGLE PCB, which 

is free, or Altium Designer which you have to pay for. RS Components has equally 

powerful software, DesignSpark PCB, which allows free use once registered. Since the 

launch in 2010, it has been warmly welcomed by customers at all levels, and continues to 

grow rapidly. 

 

DesignSpark PCB is able to support the full process from schematic design to PCB design 

with no size limitations. It can generate unrestricted Gerber and ODB++ files of your PCB 

for fabrication and create a Bill of Materials in your preferred format. Not only does 

DesignSpark PCB contain  a varied component library, you can also create and implement 

your own components onto your design using the Component Editor. 

 

RS Components is a highly regarded global distributor founded in Britain in 1937. RS 
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Components can be found in around 32 countries worldwide, featuring products from 

around 2,500 manufacturers. RS Components provides electronic components, automation 

and control equipment, measuring instruments, tools and other supplies.  

 

DesignSpark PCB connects with the electronic components library provided by RS 

Components, which features more than 80,000 kinds of electronic components and their 

symbols. To speed up your design you can do a parts inquiry, check inventory, and get 

quotes making the entire process from design to PCB quick and easy. It doesn’t matter if 

you are hobbyist or professional engineer; you can greatly simplify and speed up your 

development process. 

 

1-2 Download and Install 

 

First, we will explain how to install DesignSpark PCB, and enable the product. The steps 

are as follows: 

 

1. Go to DesignSpark PCB main website (https://www.rs-

online.com/designspark/pcb-download-and-installation) and click on 

"DOWNLOAD DESIGNSPARK PCB", as shown in Fig. 1-1. 

 

https://www.rs-online.com/designspark/pcb-download-and-installation
https://www.rs-online.com/designspark/pcb-download-and-installation
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Fig. 1-1 Download DesignSpark PCB 

 

2. Open the installation file after download, you can basically keep clicking Next 

(Fig. 1-2). 

 

 

Fig. 1-2 Click Next to finish the installation 
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3. After installation, open the shortcut on the desktop. For first time installation, a 

login window will pop up and ask you to log in with a DesignSpark account or to 

sign up a free account, as shown in Fig. 1-3. 

 

 

Fig. 1-3 For first time installation, the program will ask you to register and activate 

 

4. Click [CREATE DESIGNSPARK ACCOUNT] you will see the Register window, 

please fill out the required fields (*), and click REGISTER at the bottom, then the 

welcome screen for DesignSpark PCB will appear, as Fig. 1-4. 
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Fig. 1-4 Register and activate your account, you can then enable DesignSpark PCB 

 

Complete! Open a sample file to see if everything goes smoothly, please select File -> Open 

at the upper left corner of the screen after you open DesignSpark PCB, then the example 

folder will open automatically, you can click on any file for testing, here we choose chip 

KIT Max32.pcb within the ChipKitMax32 folder, as shown in Fig. 1-5. 

 

 

Fig. 1-5 Open sample file to confirm installation  
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1-3 Environment Introduction 

 

Circuit design is usually divided into two kinds: schematic design and a printed circuit 

board (PCB) design. The schematic design is an engineering diagram, which indicates the 

various components used as well as the working principle of the entire circuit. The PCB 

design is delivered to the circuit board manufacturers for production. The PCB design 

shows how our components are arranged wired. Hence the manufacturing services 

providers can manufacture from this PCB design, but cannot make the circuit board out of 

the schematic, although a schematic can clearly show the purpose of the circuit design.  

 

Fig. 1-6 shows the schematic and PCB design of the same circuit design. Fig. 1-6 (a) is a 

schematic, and Fig. 1-6 (b) is the PCB design. There will be further information in 

subsequent chapters. 

 

 

Fig. 1-6 (a) Schematic 
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Fig. 1-6 (b) PCB design 

 

Whether it is a schematic or PCB design, as long as you add new files or open old files, 

you will enter the corresponding working screen. In the working environment of 

DesignSpark PCB, the most important part is the general toolbar and design toolbar, shown 

in Fig. 1-7. 

 

 

Fig. 1-7 General toolbar and design toolbar  
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The schematic design and circuit board design toolbars are different, but there will 

always be a general toolbar, as shown in Fig. 1-8: 

 

 

Fig. 1-8 General toolbar 

 

Schematic design toolbar is shown in Fig. 1-9: 

 

 

Fig. 1-9 Schematic design toolbar 

 

Finally, the Fig. 1-10 is a circuit board design toolbar: 
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Fig. 1-10 Circuit board design toolbar 

 

1-4 Summary 

 

This chapter shows you how to install the free DesignSpark PCB software which is easy 

to use and introduces the development environment. 

 

The next chapter will introduce the schematic design, and then the circuit board design, 

follow our footsteps, and keep moving! 
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Chapter 2 – Circuit Diagram Design 

 

2-1 Overview of the Circuit Diagram 

 

As mentioned in the first chapter, a circuit diagram is the blueprint of circuit design. Each 

electronic component has a simple corresponding circuit symbol, and these symbols 

compose a circuit diagram. Through a circuit diagram, we can understand the approach of 

the whole circuit system design, and the interactions between the electronic components. 

Therefore, the schematic design before the production of printed circuit boards is necessary. 

 

Before using DesignSpark to design schematics, we need to take time to learn how to read 

a schematic. Fig. 2-1 shows some common electronic circuit component symbols, we will 

help you to get familiar with these circuit symbols and introduce some precautions during 

the interpretation of circuit diagrams. 
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Fig. 2-1 Common circuit symbols 

 



14 
 

2-2 Circuit Symbols 

 

Circuit symbols are standardized symbols, which means that the products that come from 

different companies can be represented by the same circuit symbols. Now let's take a look 

at some common electronic components with their circuit symbols. 

 

2-2-1 Resistor 

 

Resistor will probably be the component that you see the most often. As we can see in Fig. 

2-2, the Resistor in the circuit diagram is usually shown in two ways, one is serrated, the 

other is rectangular, and both are generic. In addition to representing an actual resistive 

element, we often simplify a load to a resistor symbol as well. Load refers to the energy 

that a system consumes, which may contain many electronic components, we will use 

resistor symbols to represent the total impedance of the system. The word, "impedance", is 

another version of Resistor. We are used to describing the total resistance of a system as 

impedance, and describing an actual resistor component by its resistance value. 

 

 

Fig.2-2 Two common circuit symbols of Resistor 

The values of the resistors we mentioned above are fixed, when you want to indicate a 
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variable resistor and a potentiometer, we'll use the other two symbols shown in Fig. 2-3. 

 

 

Fig.2-3 Variable resistor and potentiometer 

 

Variable resistors and potentiometers can change the Resistor value of the element by 

themselves. There are three pins on a potentiometer, and a variable resistor only has two 

pins. For example, a component such as a thermistor (Fig. 2-4a) can use a symbol that 

represents a variable resistor, and a potentiometer with a knob (Fig. 2-4b) uses the 

potentiometer symbol. 

 

 

Fig. 2-4a Thermistor   Fig. 2-4b Potentiometer with a knob 

 

2-2-2 Capacitor 
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We usually use two symbols to represent capacitors, which are shown in Fig 2-5. Different 

from resistors, capacitors have polarities, so they cannot be mixed. A non-polarized 

capacitor is simply represented by a pair of parallel lines, while a polarized capacitor 

symbol is composed of a curved line and a straight line which is positive. 

 

 

Fig.2-5 A none-polarized capacitance (left) and polarized capacitance with positive line 

(right). 

 

Take the electrolytic capacitor for instance, it belongs to polarized capacitors, while the 

ceramic capacitor has no polarity. The polarized capacitors have one long pin, the 

cathode, as shown in Fig. 2-6. 

 

 

Fig.2-6 The polarized capacitor has one long pin, the cathode, such as the electrolytic 
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capacitor on the left. 

 

2-2-3 Inductor  

 

An inductor has two symbols, one is a spring-like spiral, and the other is a color-filled 

rectangle, shown in Fig. 2-7. Be careful not to be confused it with the resistor symbol! 

 

 

Fig. 2-7 Inductor can be represented by spring-like spiral or color-filled rectangle. 

 

2-2-4 Switch 

 

Since there are many different forms of switch, its corresponding circuit symbol are also 

different. The simplest switch, also the most familiar form of switch, is single-pole switch 

(SPST, single-pole / single- throw), often referred to a direct-cut switch. The Single-pole / 

single-throw switch only has two endpoints, usually it is off, and it becomes a closed path 

when the switch is closed (Fig. 2-8). We use “pole” to represent the number of circuits that 

a switch can control; use "throw" to indicate the number of contacts that a switch can 
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connect to. 

 

 

Fig. 2-8 Single-pole/ single-throw switch 

 

When we have multiple loop circuits that we need to control, we will use switches with 

more contacts. Fig. 2-9 shows circuit symbols of SPDT (single-pole / double-throw) 

switches and single-pole three-throw switches. 

 

 

Fig. 2-9 SPDT (single-pole / double-throw) switches and single-pole three-throw 

switches. 

Some switches have more nodes which can simultaneously control multiple loops. Fig. 2-

10 is a DPDT (double-pole / double-throw) switch, which has six contacts in total. Note, 

because the switch is linked, as shown via the dashed line, so it's not double-pole four-

throw, but DPDT. 
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Fig.2-10 Double-pole double-throw switch with six contacts 

 

2-2-5 Power 

 

In practice, we use the power in AC (alternating current) and DC (direct current) forms. 

However, in circuit diagrams, the representation of power  varies, Fig. 2-11 is the circuit 

symbols for AC and DC power. 

 

 

Fig. 2-11 DC power supply (left) and AC (right) 

 

A battery is regarded as a DC power supply, we like to use a pair of parallel lines in the 
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circuit diagram to represent the battery, and the benefit is that it can indicate the number of 

cells in series or in parallel. Please note that the longer line the positive electrode and the 

shorter one is the negative electrode, shown in Fig. 2-12. 

 

 

Fig. 2-12 Circuit symbols of battery 

 

Sometimes we use the symbol of a voltage point and ground point as the power supply, in 

order to avoid a complicated circuit diagram. In Fig. 2-13, the positive electrode will be a 

triangle pointing upwards and the ground is a triangle pointing downwards. 

 

 

Fig.2-13 Use the symbol of a voltage point and ground point as the power supply to avoid 

a complicated circuit diagram 
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2-2-6 Diode 

 

An arrowhead with a straight line is usually used to represent a diode (Fig. 2-14). A diode 

has a polarity as well, so it requires special attention, the straight line is the negative side, 

and the triangular end is positive. 

 

 

Fig. 2-14 Circuit symbol of diode with polarity 

 

There are many different types of diode, and each category has a corresponding symbol. 

Fig. 2-15 shows some common diodes: light emitting diodes (LED), photodiodes, Schotty 

diodes, and Zener diodes. 

 

Fig. 2-15 (a) Light emitting diodes (LED) (b) Photodiodes  
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(c) Schotty diodes (d) Zener diodes 

 

2-2-7 Transistor and Integrated Circuit Element 

 

There are two kinds of transistor: bipolar transistor (BJT) and Metal-Oxide-Semiconductor 

Field-Effect Transistor (MOSFET).There are two configurations for each of the transistor, 

NPN and PNP for BJT, and P-channel and N- channel for MOSFET.  

 

 

Fig. 2-16 Two kinds of BJT circuit symbol: NPN and PNP 

BJT has three contacts, collector, base and emitter. No matter if NPN or PNP, the line 

emitter is shown with an arrow. The arrow pointed outward is NPN, while the inward arrow 

is referring to PNP. 

Same as BJT, the MOSFET has three contacts, but the names are different, they are source, 

drain and gate. Fig. 2-17 shows the MOSFET circuit symbols of N-channel and P-channel. 

MOSFETs have many different symbols, but the meaning is the same. 
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Fig. 2-17 Different MOSFET circuit symbols of N-channel and P-channel 

 

The middle arrow in the MOSFET indicates that MOSFET is with P-channel or N-channel, 

the arrow inward represents N-channel, and the outward arrow is for P-channel. 

These two transistors above are the protagonists at today's digital era. In the development 

of integrated circuit (IC) technology, people can combine tens of millions of transistors on 

a single chip, making a variety of complex microprocessor or microcontrollers, and even 

memory and signal processors. Digital logic is the key component in all digital circuits, 

which is achieved by digital logic gates. The following will describe circuit symbols of the 

digital logic gate. 

 

A digital logic gate has four main components, namely the AND gate, the OR gate, the 

XOR gate and the NOT gate. And they have corresponding circuit symbols, which are 

shown in Fig. 2-18. 
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Fig. 2-18 Digital logic gate 

 

If a circle is added on the top, the symbol represents the opposite meaning. See Fig. 2-19. 

 

 

Fig. 2-19 Adding a circle on the top has the opposite meaning 

 

Sometimes the input of the logic gate may be more than two, but the meaning is the same. 

Digital logic gates are identified mainly by the shape of the circuit symbol and not by its 

size or number of pins. However, no matter how many inputs are there, digital logic gates 

only have one output. 

 

What we described above are the basic transistors and the integrated circuit component 

symbols. However, we also need to identify the other integrated circuit elements, such as 

common voltage regulating elements7805, 7803, Timer 555, ATmega 328, ATtiny 45 and 

other microcontrollers. We often use rectangles to represent all these kinds of integrated 
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circuit elements, and mark the name of each pin. See Fig. 2-20. 

 

 

Fig. 2-20 Integrated circuit elements use rectangles as their symbols, and mark the name 

of each pin 

 

Since each integrated circuit element may have great differences between each other, it is 

very important to mark the position and the name of each pin. 

Furthermore, the operational amplifier also has a specific circuit symbol, triangular in 

shape, as shown in Fig. 2-21. Sometimes you will see five pins: the non-inverting input (+), 

the inverting input (-), output, and two power input pins; sometimes it only has three pins; 

input, power and ground. 
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Fig. 2-21 Operational amplifier 

 

2-2-8 Other Common Elements  

 

Next, we are going to introduce some other common circuit symbols of electronic 

components. Fig. 2-22 shows the quartz oscillator (Crystal) and the resonator. 

 

 

Fig. 2-22 Quartz oscillator and resonator. 

 

A quartz oscillator is an important and common component. They can generate clocking 

signals. A quartz oscillator has two pins, and a resonator is a quartz oscillator connected to 

the capacitor, with three pins. Whether it is powered or sending signals, we used a variety 

of connectors to organize lines. Fig. 2-23 shows more common connector symbols. 
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(a)                         (b)   (c) 

Fig. 2-23 Connector symbols 

 

In Fig. 2-23, (a) and (b) represents an electric wire connector, and (c) is the power pole of 

the connector. 

 

A transformer’s circuit symbol is shown in Fig. 2-24, the transformer is usually two sets 

of coil symbols, separated by a straight line. 

 

 

Fig. 2-24 Transformer’s circuit symbol 

 

A relay is composed of a coil and a switch symbol, shown in Fig. 2-25. 
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Fig. 2-25 Relay is composed of a coil and a switch 

 

A buzzer and speaker have their corresponding circuit symbol shown in Fig. 2-26 (a) and 

Fig. 2-26 (b) below. 

 

 

(a)              (b) 

Fig. 2-26 (a) Buzzer (b) Speaker 

 

A motor is usually represented by a circle and includes the letter M inside with both ends 

of the electrodes, as shown in Fig. 2-27. 

 

 

Fig. 2-27 Motor’s circuit symbol 
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Of course, there are thousands of electronic components, and the circuit symbols are not 

the same, but the symbols we introduced above should allow you to understand more than 

90% of the circuit diagrams. Usually, the circuit symbol design will be similar to the 

operational principle, but for clarity the name and value of the components will be marked 

on a circuit diagram. The names of these electronic components will represent only one to 

two letters to save space. Next, we are going to introduce the names of different elements 

that might be used. 

 

2-2-9 Names and Values 

 

A circuit symbol is usually accompanied by its name and value, the value of which is the 

most important information. Through this value, we can identify and understand the 

components with its corresponding value. For example, we can tell the quantity of the 

resistance by Ohm, and know it is an inductor by seeing Faraday. While other elements 

such as integrated circuit components, its value might have certain relation of the main 

chip.  

 

As previously mentioned, we will use one or two letters with symbols to represent 

electronic circuit components, such as R represents Resistor, L on behalf of inductance, C 

represents the capacitance and so on. When using multiple components, a number will be 

added, for example, if there are three resistors, their names will be R1, R2, and R3. Table 
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1 lists some of common electronic components’ representative letters. 

 

Table 1 – Names for common electric components 

Representation Component 

R Resistor 

C Capacitor 

L Inductor 

S Switch 

D Diode 

Q Transistor 

U Integrated Circuit 

Y Crystal 

 

Usually the representative letter of an electronic component is the first letter of its name in 

English, take resistor for example, its representative letter is R. However, there are 

exceptions to this rule, like inductor has the representative letter L, this is because letter I 

is used to represent current. 

Sometimes, not all of the circuit diagrams will use the standard representative letters, as 

some schematics will directly use IC to represent the integrated circuit component instead 

of U. Even so, a circuit diagram should still be properly understood, with the circuit 

symbols and your own judgment. 

 

2-3 Schematic Interpretation 
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After understanding the circuit symbols, basically you are ready to read a circuit diagram, 

and now we just need to recognize some of the rules to connect these electronic components. 

 

2-3-1 Loops, Rendezvous Points, and Nodes 

 

Electronic components are combined with each other by lines to form a loop, shown in 

Fig. 2-28. 

 

 

Fig. 2-28 Electronic components are combined with each other by lines to form a loop 

     

When a line is divided into two lines, it gives rise to a meeting point or branch point. We 

use the symbol node, a filled circle, to represent the meeting point of these lines, as shown 

in Fig. 2-29. 
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Fig. 2-29 We use node to represent the meeting point 

 

Note: If you see two intersecting lines without nodes, it indicates that they are actually 

two separate lines, as shown in Fig. 2-30. 

 

 

Fig. 2-30 When nodes exist this means the lines are connected, no nodes means they are 

two separate lines 

 

Sometimes, in order to avoid filling a diagram with too many lines, we use tags to label 

the corresponding pins instead of lines, as shown in Fig. 2-31. 
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Fig. 2-31 Use tags to label the corresponding pins to avoid filling the diagram with lines 

 

Above is what we need to pay attention to in the interpretation of circuit diagrams. Let’s 

begin circuit diagram design in the following pages.  

 

2-4 Circuit Diagram Design 

 

2-4-1 Establish a Circuit Diagram 

 

To create a circuit diagram, first click “File” on the upper left corner, and click “New” to 

start a new file, as shown in Fig. 2-32. 
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Fig. 2-32 Click “File” to add a new file 

 

Next, choose “Project” and assign a name for it, saving project file in appropriate catalogue. 

Then, open again “New” window and choose “Schematic Design”, and check “Use 

Technology File” option, select default and press “OK”, shown in Fig. 2-33. Selecting this 

option can help you quickly create a circuit diagram. Technical files store the preferences 

of the composition, such as background color, background grid lines, standard units, 

composition parameters (like lines, connection points, and text) and so on. Therefore, you 

may directly select default, with no need to make adjustments when just getting started. 

You can establish a dedicated technical file according to your preference in the future. 
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Fig. 2-33 Choose Schematic Design, and then choose default 

 

After you press “OK”, a new circuit diagram will be opened. 

 

 

Fig. 2-34 Press “OK”, a blank circuit diagram will be opened 

The mouse operation is as expected, left key to choose, and right key is used for 

commencement of options. Note that the middle scrolling wheel rolls out for zoom in the 

screen, rolls in to zoom out the screen, and you can pull the design by pressing the middle 

wheel without releasing. 
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2-4-2 Add Components 

 

There are three methods to add new components: use the “Interaction bar”, click on “Add 

Component” or by using an online “PCB Part Library”. 

 

Method 1: Use the “Interaction bar” 

 

The interaction bar has been preset on the right screen after the opening of a new circuit 

diagram, shown in Fig. 2-35. If you do not see it, press F9, the interactive bar will pop up. 

 

 

Fig. 2-35 Interaction bar has been preset on the right screen, if not, press F9 

 

Then select “Add Component” in the lower right corner of the Interactive bar, and choose 
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"All Libraries" at the top of the drop-down menu, you will see the component library, as 

shown in Fig. 2-36. In the interactive bar, you can instantly preview the component symbols 

and PCB symbols. If you want to add components, just use the mouse to drag the circuit 

symbols onto the design screen on the left. 

 

 

Fig. 2-36 Select “Add Component” in the lower right corner of the Interactive bar, choose 

"All Libraries", and you can drag circuit symbols onto the design screen. 

     

You can see the library that DesignSpark has built from the drop-down menu. If you want 

to add or remove a database, you can through Library Manager. To start the Library 

Manager, click Library Manager in the toolbar on the top of the screen, as shown in Fig. 2-

37. 
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Fig. 2-37 Click library manager to manage database 

After access into the Library Manager, click the Folders tab, you'll see all the current 

databases. To enable or disable a database, simply select the database first, and check 

Folder Enabled on the right, as shown in Fig.2-38. 

 

 

Fig. 2-38 Checking the Folder Enable options to determine whether to enable database 

 

Since the later chapters require some examples, please make all folders enabled. 
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Method 2: Click on “Add Component” 

 

This method is similar to method one, but with more steps, and the function is more 

complete. First you have to click “Add Component” icon, the shortcut key is F3, and its 

position in the frame is shown in Fig. 2-39. 

 

Fig. 2-39 Click “Add Component” icon to add components 

 

The next dialogue window will appear, the benefit of using this method is that you can 

search components, as shown in Fig. 2-40. You can click the “Find” button to search for 

components, which will be very practical when adding some ICs. In addition, you can also 

preview circuit component symbols and PCB symbols in this window. 
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Fig. 2-40 Click “Find” to search components 

 

For example, if you want to add a 555 timer, you can click on the search button to search. 

Suppose we want to see all models of 555 timers, you only need to type 555 in the search 

box, and set the search condition as Contains, so all the electronic components with 555 in 

their name are displayed, as shown in Fig. 2-41. 
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Fig. 2-41 Searching for 555 timers 

 

When you click the search results, you can still use the preview function. Click on various 

components, the schematic symbol and PCB symbol of the element can still be seen. 

 

To add an element, you can just double-click the left mouse button, and then the screen 

will jump back to the design window. You can continue to add multiple elements, press 

<Esc> to stop adding new elements, as shown in Fig. 2-42. 
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Fig. 2-42 Click the left mouse button to add components, press <Esc> to stop adding. 

 

Method 3: Use PCB Parts Library 

 

The two methods described above are using the built-in DesignSpark Library, in addition 

to the built-in libraries, we can also add elements through a free online database, PCB Part 

Library. If you want to use PCB Part Library, you must first download and install the 

Library Loader. Then register and activate your account. 

 

To use PCB Part Library, open the Library Loader window and click on the Search for 

Parts label at the top of the window, as shown in Fig. 2-43 

 

 

Fig. 2-43 Tap Search for Parts at the top of the window 
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A component search engine website will automatically be opened in a new window. Search 

and download the required component libraries. The downloaded component library will 

appear straight in DesignSpark PCB. If you are unable to find for your component, you can 

submit a request for that component library and it will be created just for you within 48 

hours.  

 

The methods mentioned above will help you to add new components. After you have all 

the components you want the next step is to set the value of each component, you can click 

the right mouse key to choose Properties or double click the left mouse to get into the 

properties setting page. Next, choose the Values tab to set the values, as shown in Fig.2-44. 

Take the resistor for example; its value is 1K. 
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Fig. 2-44 Components value setting 

    

To rotate the component, click the right mouse key on the component and choose Rotate, 

there are many options for rotation. But hot keys are more recommended: press R to make 

the component turn 90 degrees counter-clockwise; press Alt+R for 90 degrees clockwise; 

press F to flip, the effects on a resistor are shown in Fig.2-45. 

 

 

Fig. 2-45 Press<R>, <Alt+R>, <F> to rotate the component 

 

2-4-3 Add Wiring Lines and Power Symbol 

 

There are also three ways to add lines, we can drag contacts by pressing on the contact 

twice or press the left side of the design toolbar button to add new wiring lines. When the 

connection is established, X, which was originally shown will disappear, it means the 

connection is complete. 
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Fig. 2-46 Directly drag, double-tap the contact or click the Add connection button to 

generate wiring lines to connect elements 

 

As mentioned in the previous section, whether the exchange line is simply passing the 

intersection without communication depends on whether the intersection has a solid node 

or not. To produce the intersection node, simply click the line you want to communicate 

with in the establishment of the line, it will produce the solid node, if the line is not in 

contact, the node will not be created, as shown in Fig. 2-47. 

 

 

Fig. 2-47 Produce a solid node on the intersection of two lines to show that the two lines 

are joined. 
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As we mentioned in the previous section, you can use the power and ground symbols in 

the circuit diagram to simplify the circuit. To join power or ground symbols, do the search 

when you add the elements. When the power or ground symbols are added to the circuit, 

they will automatically inherit the property name of the loop they belong to, and a dialog 

box will pop up, all you need to do is click OK, the final result is shown in Fig. 2-48. 

 

 

Fig.2-48 Add power and ground symbols 

 

Note that the power and ground symbols in the circuit diagram is only for illustrative 

purposes, when converted into a PCB diagram they will not be visible. 

 

2-4-4 Join the Connector with a Reference Label 

 

Next, we are going to talk about how to use the connector and generate a reference label. 
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At the place where you add elements, select Connector.cml in the components type menu 

and you'll see a wide variety of connectors. We use the interactive column to add parts. Of 

course, you are also able to use other methods. Select the D9F connector here, as shown in 

Fig. 2-49. 

 

Fig. 2-49 Add a D9F connector 

 

As mentioned earlier, we can use the reference labels to make a circuit diagram simpler 

and more straightforward. After you add a reference label, although there will be no 

physical connection of the elements on the circuit diagram, after conversion to a PCB 

diagram, they will be connected. To add tags, please press add elements, and select 

schema.cml in the category, look for the TO element and pull it onto circuit diagram, 
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connect it to the contact that you want to extend, as shown in Fig. 2-50. 

 

Fig. 2-50 Add TO component and connect it to the contact you want to extend 

 

Next, set the reference name, right-click the TO element and select <change net>, and set 

a name and category you want, the name in Fig.2-51 is set Sig_1, and the class is set to 

Signal. 

 

 

Fig. 2-51 Set the corresponding name to the loop 
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After doing the corresponding settings, we can display the name and make the diagram 

easy to read. Right-click on the connection between TO and the contact point and choose 

Display net name, it will show the label name, as shown in Fig. 2-52. 

 

 

Fig. 2-52 Click Display net name to establish the reference label 

 

Then you just need to repeat the operation on the corresponding elements you want. If you 

only want to extend the line, you can select another TO; if you want to extend to the other 

components inner part, you can choose the FROM element, as shown in Fig. 2-53. 

 

 

Fig. 2-53 Use another TO or FROM elements to establish corresponding connections 
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2-5 Summary 

 

We started this chapter by describing how to read a circuit diagram, and recognize the 

symbols of the common components and the ways to connect electronic components. In 

the schematic design, we introduced a number of practical tips, including add a new 

element, the establishment of the line and the use of tags to simplify the circuit, etc., we 

recommend you practice more to master these skills. In the next chapter, we will introduce 

the principle of the printed circuit board first, and then explain how to convert a circuit 

diagram into a PCB diagram, so make sure you are competent in the skills and concepts in 

this chapter before you read on. 
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Chapter 03 – Designing a Printed Circuit 

Board 

 

3-1 Introduction to the Printed Circuit 

Board 

 

Circuit boards play an important role in our life. They exist in computers, cell phones, and 

any other electronics that we use every day. Before diving into the know-how of designing 

a circuit board, we would like to give you some basic knowledge about printed circuit 

boards. 

 

A printed circuit board, which people usually refer to as a PCB, is composed of layers of 

different materials. The most basic PCBs usually have only copper and fiberglass layers, 

while some more professional PCBs contain solder mask and silkscreen layers, as shown 

in Fig. 3-1. 

 

 

Fig. 3-1 The structure of a printed circuit board 
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The strength of a PCB comes from the fiberglass layer, which is a strong yet lightweight 

material and is often used as base material for PCBs. Sometimes you can find some PCBs 

that use epoxies or phenolic as base materials. These are cheaper materials but also less 

durable. In addition, as their melting temperatures are also lower, they’ll delaminate if you 

keep the soldering iron on them for too long.  

 

The base materials are enclosed by the copper layer, which is attached using some special 

glue. There can be more than one copper layer such as two, four, six, eight, twelve, or 

sixteen and so on. Each copper layer is separated by a layer of insulator. More copper layers 

mean you can have more traces, but it is also more difficult to debug. 

 

On the top of the copper layer is the solder mask layer, which is often green. However, 

there are also other colors available such as black, blue, or red, depending what the 

manufacturer can offer. The purpose of having the solder mask layer is to avoid the solder 

flowing around the board and to insulate the copper traces, as shown in Fig. 3-2. 
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Fig. 3-2 A PCB with solder mask layer. Image source: https://learn.sparkfun.com  

 

In Fig. 3-2, you can see that the copper traces are all covered by the solder mask and only 

the silver rings and the rectangular pads (for a surface-mount device, SMD) are exposed 

for soldering. This can protect the board from short-circuiting and oxidation.  

 

Fig. 3-3 is a PCB without the solder mask layer. As a result, you can see the exposed copper 

traces and the fiberglass.  

 

https://learn.sparkfun.com/
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Fig. 3-3 A PCB without the solder mask layer. The circuit traces are exposed. Image 

source: https://learn.sparkfun.com 

 

Finally, on the top of the solder mask layer is the silkscreen layer. The silkscreen layer 

layouts all the labels, such as pinout, name of the manufacturer, and logos. Fig. 3-4 is an 

Arduino MEGA2560, which shows an example of silkscreen (the white fonts). 

 

https://learn.sparkfun.com/
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Fig. 3-4 The silkscreen layer adds labels on the PCB such as pinout, logos and name of 

manufacturer.  

 

Besides the mounting holes, sometimes you will see some tiny little holes on a PCB. These 

are called vias. A via can pass a signal between different layers. Some vias are covered by 

solder mask to prevent them from being soldered, while the other kind of the vias are 

uncovered so that the connectors and other components can be easily soldered. Fig. 3-5 

shows an example of covered vias.  
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Fig. 3-5 Vias are used to pass signals between layers. This image shows two vias from the 

front and back of a PCB 

 

The function of vias is further illustrated in Fig. 3-6. After drilling a through hole and 

making it conductive by electroplating, it will then have the ability to conduct a signal 

between different layers. If a via is covered by solder mask, you will only see a hole and 

no metal pad. 

 

 

 

Fig. 3-6 How a via can pass a signal between different layers 

 

With a PCB that has multiple layers, sometimes we may want to connect only some of the 
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layers. Therefore, instead of a through-hole via, there are also blind vias and buried vias. A 

blind via only passes through some of the layers and the surface of a PCB, and a buried via 

only passes through several layers within the PCB and cannot be seen from outside.  

 

From the design aspect, it is better for the vias to be smaller so that we can have more space 

to route traces. However, the size of the vias depends on the manufacturers. 

 

3-2 Board Layout 

 

Once we have the schematic ready, we can then use the tool in DesignSpark to transfer the 

schematic into PCB layout. As we have already shown you how to create a schematic in 

the previous chapter, we are not going to create a new schematic here. Instead, we will use 

a built-in example to show you the process. Please open the file “riaa_amp.sch” from the 

example folder (…/DesignSpark 8.0/Examples), as shown in Fig. 3-7. 
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Fig. 3-7 Open the “riaa_amp.sch” from the DesignSpark example folder. 

 

We chose this example because it is one of the simplest examples for us to show. RIAA is 

actually an acronym of the Recording Industry Association of America.  The reason why 

this circuit was named as RIAA was because it realized a specification called “RIAA 

equalization”. In other words, this is a circuit for a phonograph record amplifier and one of 

the chip, AD844AN, which is an amplifier. A phonograph record is the predecessor of CDs.  

 

Back to the topic, to transfer this schematic into the PCB layout, click the “Translate To 

PCB” from the “Tools” menu, as shown in Fig. 3-8. 
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Fig. 3-8 Click “Translate to PCB” to transfer you schematic to PCB layout 

 

After clicking the button, the PCB transfer wizard will show up. Click next on the first 

page which describes the wizard. In the second page, you will need to confirm the unit you 

are using and the technology file you want to use. Here, please check “Use Default 

Technology”. DesignSpark also comes with some other pre-defined technology files such 

as the “2sig2plane.ptf” below the default option, which is a four-layer file that has two 

signal layers, one power layer and one ground layer. However, as our circuit uses dual 

power (+15 V and -15V), we do not need to use that technology for now. For the unit, 

please select metric (mm) and set the precision to 2, as shown in Fig. 3-9. 
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Fig. 3-9 Choosing technology file and unit 

 

Then, click next and enter the layer designer. For layers, please select “2 Layer Board”, as 

shown in Fig. 3-10. The number of layers and all the other settings can be changed after 

you have created the PCB layout. 
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Fig. 3-10 Layer settings 

 

Next we will need to set the size and the shape of the board. Please set the width to 80mm 

and the height to 60mm, and then click next, as shown in Fig. 3-11. 
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Fig. 3-11 Setting the size of the board 

 

After finishing the size settings, we can go ahead to set up the component placement and 

routing requirements. You can choose to let DesignSpark do the component placement and 

routing for you, and you can still make changes after. However, to gain more practice, here 

please select “Arrange Outside the Board”, which means you will need to do everything 

manually, as shown in Fig. 3-12. For part placement, we will show you how to do that 

automatically later. As for routing, although auto-routing seems promising, we would like 

to practice how to do it. Plus, it is always better if you do the routing manually.  
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Fig. 3-12 Choose “Arrange Outside the Board” to place the component and route the net 

manually 

 

Finally, you will need to select the path to save the file, and then the PCB layout will be 

generated, as shown in Fig. 3-13. As we mentioned in chapter two, you need to activate all 

the libraries in the Library Manager, otherwise you might see some components missing.  
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Fig. 3-13 The generated PCB layout. Remember to activate all the libraries in the Library 

Manager 

 

Take a look at the PCB layout, you will find that all the soldering points were already 

generated, which is very convenient. If you want to change any settings, you can go to 

“Settings” from the top menu and then click “Design Technology”, as shown in Fig. 3-14.  
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Fig. 3-14 Go to Settings -> Design Technology to change any board-related settings 

 

In Fig. 3-14, the “Layers” tab is shown. Here you can check all the layers in your board 

and their corresponding color. Because we are building a two layer circuit board, you can 

see that there are two layers labeled as electrical for usage. 

 

3-3 PCB Design 

 

Once we generated the PCB layout successfully, we can then start working on component 

placement, trace routing, and copper pouring.  

 

3-3-1 Component Placement  
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To place the components, simply use your mouse and drag them to the position you want. 

You can also ask DesignSpark to place the components for you automatically. To do that, 

select “Auto Place Components” from “Tools”, and then click “All Components”, as shown 

in Fig. 3-15. While placing the components, DesignSpark will try its best to optimize the 

placement to make sure the traces between components will be the shortest. 

 

 

Fig. 3-15 Select Tools -> Auto Place Components -> All Components to place the 

components automatically 

 

Once you click the button, a window will pop up for you to select the conditions. Basically 

all you need to do is to set the minimum space allowed between components. As we set the 
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board size to 80mm x 60mm, we have plenty of space to use. Here we set the space to 6mm, 

as shown in Fig. 3-16, but you can try a different distance. 

 

 

Fig. 3-16 Setting requirements for auto-placing components 

 

Once you are done with the settings, click OK and DesignSpark will start computing the 

optimal placement for the components, as shown in Fig. 3-17. 
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Fig. 3-17 Auto-placing components 

 

You can use you mouse the change the placement anytime you want. The process is similar 

to schematic design. After selecting the component, you can press <R> on your keyboard 

to rotate the part 90 degrees counter-clockwise, <Alt+R> for clockwise rotation, and <F> 

to flip the component. These commands are also available if you right click the part with 

your mouse. Meanwhile, you can also drag the green edges to change the size of the board 

directly. See Fig. 3-18 for the adjusted placement. 
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Fig. 3-18 The manually-adjusted part placement 

 

3-3-2 Routing the Board  

 

Although DesignSpark PCB comes with the auto-route function, it is not recommended to 

users who wants to have better control over the tracks in the final design. Manual routing 

brings usually better results in terms of preventing ECM interferences. 

We will still walk you through how to auto-route before we introduce some good practices 

in PCB routing. 
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For auto-routing, select “Auto Route Nets” in the “Tools” menu, and then click “All nets”, 

as shown in Fig. 3-19. 

 

 

Fig. 3-19 Auto-routing 

 

In the setting window, you can basically leave all the options as default (“As Necessary”). 

Also, check “Miter Track” for better design, as shown in Fig. 3-20. Checking “Miter Track” 

will prevent the traces from having an angle that is smaller or equal to 90 degrees.  

 

Having a via or a turning angle that is smaller or equal to 90 degrees tend to change the 
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impedance of the trace, and hence impacts the quality of the signal. If you really need the 

trace to turn 90 degrees, then use two continuous 45 degrees instead. Also try to use less 

vias, if possible. 

 

 

Fig. 3-20 Setting up the requirements for auto-routing 

  

Once you finished setting the requirements, hit “Route” to start the process. A window will 

pop out once the routing is finished, which shows the completed percentage and how many 

vias are used, as shown in Fig. 3-21.  
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Fig. 3-21 A report will pop out once the auto-routing is finished 

 

Fig. 3-22 shows the results of auto-routing. Different colors represent different layers. 

 

 

Fig. 3-22 The routed board using auto-routing 
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Because we are building a two-layer circuit, you can see that the traces have two colors. 

The two layers can be connected using a via. In this example, the red traces represent the 

top copper layer and cyan traces are the bottom layer. 

 

To hide or show different layers, press <F9> or click “View” from the top menu and select 

“Interaction Bar”. Check the layers you want to show and un-check the layers you want to 

hide, as shown in Fig. 3-23. 

 

 

Fig. 3-23 You can show or hide layers using the interaction bar 

 

From generating PCB layout, part placement to routing, DesignSpark provides a very easy 

and straight way for you to design your own PCB. However, if you look closer at Fig. 3-

22, you will find that this is not the best that you can route as it contains more vias and 

bizarre trace paths. This is why we mentioned that it would be a better practice for you to 

route the board manually. Although is a very powerful tool, routing a board itself is a very 

complicated task and there are numerous ways to route the board. Routing a multi-layer 

board is especially difficult, and a professional PCB routing software is usually extremely 
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expensive. For a simple circuit, you can try the auto-routing first, and then fine tune the 

results by yourself. 

 

While routing manually, there are several things we would like you to keep in mind. First 

is the trace width. Having wider trace enables more current to pass through, but it also takes 

more space. Table 3-1 lists the relationship between trace width and the corresponding 

current. 

 

Table 3-1 Trace width versus max current 

Trace width (mm) Current (A) 

0.2 0.5 

0.3 0.75 

0.5 1.25 

1.25 2.5 

2.5 4 

5 7 

8.12 10 

 

Usually the traces that carry power will have the largest width. This is one of the factors 

that DesignSpark considered while doing auto-routing (see Fig. 3-22). As a result, in Fig. 

3-22, you can see that the power lines are wider than others. If you want to change the trace 

width, simply right click the trace, and select “Properties”, “Width”, as shown in Fig. 3-24. 
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Fig. 3-24 Changing the trace width 

 

When placing the soldering pad, make sure the hole size is big enough for your component. 

You can change the properties of the soldering pad by right clicking it and select 

“Properties”. Besides the hole size, you can also change the shape of the soldering pad. For 

example, the soldering pad of the first pin of an IC is usually square instead of round. You 

can also change the diameter of the copper surrounding the hole, as shown in Fig. 3-25. 

Take note that you are required to check on the pad style exception in order to change the 

diameter. 
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Fig. 3-25 Setting the properties of a soldering pad 

 

For routing a board, in addition to the rule that you should prevent the trace from making 

a 90 degrees turn, you should also check if the traces are too close to each other.  

 

DesignSpark can help you take care of some commonly made mistakes, such as 

overlapping the soldering pads or traces, by using the Online Design Rule Check. We will 

cover this later in this chapter. 

 

If your system has bus signals such as data bus or address bus, make sure to keep them 

parallel to each other, as shown in Fig. 3-26. For clock signals, parallel arrangement is not 

feasible because there will be crosstalk noise between the parallel traces. However, 
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crosstalk noise will only happen when the signals are alternating. For bus signals, all the 

signals change simultaneously and will latch until the next status update, so crosstalk noise 

does not exist in bus signals. Keeping the bus signals parallel to each other can help them 

synchronize better and to reduce the delays between the signals. This is especially 

important for high speed systems. 

 

 

Fig. 3-26 It is a good practice to keep the bus signals parallel to each other 

 

Now we have some basic rules of routing the board in mind, we can start improving the 

auto-routed traces that were generated by DesignSpark. Click “Add Track” button  on 

the PCB design tool for manual routing. For example, the traces in Fig. 3-22 do not need 

vias and can stay on the same layer instead.  
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Fig. 3-27 The traces here do not need two vias; they can stay on the same layer 

 

Using the manual routing tool is very straightforward. All you need to do is to click the 

soldering pad and then route the trace, as shown in Fig. 3-28.  

 

 

Fig. 3-28 Routing the trace manually 
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If you want to change the layer of the trace, right click the trace and select “Change Layer”, 

as shown in Fig. 3-29. 

 

 

Fig. 3-29 You can change the layer of the trace anytime 

 

Keep in mind we do not want the trace to have 90-degree turns. To change this, double 

click the trace, then move the mouse to change the angle, as shown in Fig. 3-30. 
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Fig. 3-30 Changing the 90-degree turns to two 45-degree turns 

 

That’s it. To gain more practice, you can try to improve the rest of the circuit on your own. 

Since this is a simple circuit with no data bus or clock signal, you only need to delete 

excessive vias and change the routing and trace width. To create a new via, simply connect 

the traces of different layers, and DesignSpark will create a via for you. Fig. 3-31 is a much 

better routing. 
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Fig. 3-31 A better routed board 

 

Another useful tool is the “Cross Probe”, which can let you cross reference the same pin 

on the schematic and PCB. To use it, you can either press <Shift+X> or select from the 

“Edit” menu. Once you activated the Cross Probe, click on one of the pins on your PCB, 

then it will also show up in the schematic, as shown in Fig. 3-32. 
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Fig. 3-32 Using Cross Probe to cross reference the pin on PCB and schematic 

 

If you want both the PCB and the schematic design to show evenly in your working window 

as Fig. 3-32, click “Window” on the top menu, and then select “Tile Vertically”. 

 

It is also useful to add some mounting holes for your board, which can be achieved by 

adding soldering pad  from the toolbar. The common diameter of a brass space is 3mm, 

therefore, you can add a 3.1mm soldering pad. Finally, you can also add texts on the board 

which will be on the silkscreen layer. To add texts, click text tool  from the tool bar, 

and enter the text you want to add. Here we entered “RIAA Amplifier” and select the layer 

as “Top Silkscreen”, as shown in Fig. 3-33. 
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Fig. 3-33 Adding text 

 

The board with mounting holes and text is shown in Fig. 3-34. 

 

 

Fig. 3-34 The board with mounting hole and custom text 
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3-3-3 Copper Pour 

 

Copper pour refer to the areas on a PCB that are covered with copper. While designing 

PCBs, we can assign the areas that need copper pour. During etching, these areas will be 

kept together with the traces. Copper pour is especially useful for those boards that do not 

have the power and ground separated in different layers. By having copper pour, we can 

increase the ground area, which can provide better noise suppression. We are surrounded 

by a tremendous amount of signals in our daily life. Once these signals enter your board, 

they become noise. Having a larger ground area help send this external noise directly to 

ground, hence better noise suppression. Besides external noise, copper pour can also help 

avoid internal noise. In addition, because copper is also a very good material for heat 

transfer, copper pour can also help with heat dissipation of the system. Finally, having 

copper pour keep more copper in your board, which reduces the cost of the etching solution. 

 

The downside of copper pour is that the structure of copper pour is close to patch antennas. 

As a result, the copper-poured area will act like an antenna and thus pick up noise. Also, if 

the copper pour is too thick, the heat will dissipate very fast and may make soldering more 

difficult. 

 

In summary, not every board needs copper pour. It is based on your requirements and 

applications. 
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To add copper pour to your system, as its main purpose is to increase ground area, we need 

to pinpoint the ground traces first. To do that, navigate to the interactive toolbar and select 

the “Goto” tab (hit <F9> if you do not have the interactive toolbar opened). Then, select 

“Net” and click 0V, which is equal to ground, as shown in Fig. 3-35. 

 

 

Fig. 3-35 Showing the ground traces 

 

Double click 0V, and then you will see the ground trace highlighted in your PCB layout, as 

shown in Fig. 3-36. 

 



87 
 

 

Fig. 3-36 The ground traces are highlighted 

 

Before pouring copper, we need to define the area. Click the “new copper pour”  from 

the toolbar, and then use your mouse to draw the area you want to have copper pour, as 

shown in Fig. 3-37. You do not need to stay within the board, the software will tune itself 

while pouring. 
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Fig. 3-37 Define the area for copper pour 

 

During laying out the copper pour area, you will find out that the line is red, which means 

your copper pour will be on the top layer. This is fine because most of the ground traces 

are within the top layer. Right click the line and select “Properties” if you want to change 

the layer, as shown in Fig. 3-38. 
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Fig. 3-38 Changing the layer of copper pours 

 

When making the copper pour, DesignSpark will make sure there is space between the 

traces and the copper pour (except ground traces). If you want more space for the mounting 

holes, you can make the hole diameter larger and then change them back after copper is 

poured. 

 

Then, we need to define the area that needs to be kept free from copper pour. Here we use 

the 9-pin D shape connector as an example. To keep it from copper pour, select the “new 

copper pour” from the toolbox and then select the area where you do not want the copper 
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pour, and right click the area for “Properties”, and select “Pour Keepout”, as shown in Fig. 

3-39. 

 

 

Fig. 3-39 Select the area that need to be kept out from copper pour 

 

Once you defined all the areas, you can then click copper pour   from the toolbox, and 

select 0V, as shown in Fig. 3-40. 
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Fig. 3-40 Setting up copper pour 

 

Finally, reduce the diameter of the mounting holes, the result is shown in Fig. 3-41. 

 

 

Fig. 3-41 Changing the diameter of mounting back 

 



92 
 

You can see that there is space between traces and the copper pour except the ground 

traces, as shown in Fig. 3-42. 

 

 

Fig. 3-42 There is space between copper pour and the trace 

 

3-4 Debugging 

 

There are some useful tools in DesignSpark that can help you check your design. Some 

tools are already activated by default, and you have been using them. Here we would like 

to go through some of these tools. 

 

3-4-1 Design Rule Check 
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The design rule check tool can help you check some general designs such as spacing, 

overlapping…and so on. To use it, click the “Design Rule Check”  from the toolbox, 

and then a window will show up, as shown in Fig. 3-43. All you need to do is to check what 

you want to inspect and press “Check”. 

 

 

Fig. 3-43 Design rule check 

 

A report in .txt format will be generated once DesignSpark has finished analyzing the 

circuit, as shown in Fig. 3-44. 
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Fig. 3-44 A report will be generated after design rule check 

 

In Fig. 3-44, you can see that there is no error in the circuit (No errors found). You can also 

navigate to the interactive toolbox and select the error tab to check the results, as shown in 

Fig. 3-45. Since there is no error, the block is blank. 

 

 

Fig. 3-45 You can use the interactive toolbox to show the check result 
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3-4-2 Online Design Rule Check 

 

The online design rule check is enabled by default. It will notify you immediately if there 

is any error in the circuit. You can turn on or off this feature by going to the “Tools” menu 

and select “Online DRC”, as shown in Fig. 3-46. 

 

 

Fig. 3-46 Online design rule check gives you immediate notification if anything goes 

wrong 

 

If you have the online design rule check enabled, a window will pop out when there is an 

error in your design. For example, in Fig. 3-47, we overlapped two soldering pads on 

purpose, and the window popped up. 
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Fig. 3-47 The online design rule check will warn you if you make a mistake 

 

3-4-3 Generating 3D Model 

 

Another nice feature of DesignSpark is that it can help you generate a 3D model of your 

circuit, which you can export to any other CAD software. This can also help you debug 

your circuit. With the 3D model, you can check if the components are too close to each 

other or if the routing is appropriate. To generate a 3D model, simply click “3D” on the top 

menu and then select “3D View”, as shown in Fig. 3-48. 

 

 

Fig. 3-48 Generating a 3D model of your board (front and back) 
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You can change the properties of the model, such as color, unit, background, and thickness, 

by right clicking it. 

 

3-5 Importing and Exporting 3D Model 

 

In this section, we would like to give you more detail on how to combine your PCB model 

with CAD software. For example If you want to design a case for your PCB, you can export 

the 3D model to a CAD software; If you already have a case and its 3D file, you can also 

import the file to DesignSpark PCB so that you can match the positions of dimensions of 

the mounting holes on your PCB. 

 

3-5-1 Exporting IDF Format to CAD Software 

 

Before exporting the 3D file, we need to define the height of the component. In 

DesignSpark, every component should have clear 2D dimensions, but the default height is 

all zero. Therefore, if you export the 3D file directly, all the components will not have 

height information. However, because most of the ICs and electrical components are all 

very short, their height can be ignored, you only need to specify the highest component in 

your circuit. In our example, the D-shape connector is the highest component on the board, 

so we will need to specify its height. This information can be found onRS Components’ 

website. For this connector, the height is 12.5mm, as shown in Fig. 3-49. 



98 
 

 

Fig. 3-49 Finding the component’s dimension from RS Components’ website (image 

source: http://rs-online.com/) 

 

To add this information, right click the connector and then click “Edit Component Library”. 

In the window, look for the properties setting,  and then go to the “Value” tab, and set 

Height to 12.5mm, as shown in Fig. 3-50. 

 

http://rs-online.com/)


99 
 

 

Fig. 3-50 Setting the height of the component 
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After setting the height value, go back to the PCB design layout, right click the component 

again, and then select “Update Component”. To double check, right click the component 

again and select “Value”. You should see the height information now, as shown in Fig. 3-

51. 

 

 

Fig. 3-51 The height value is now added 

 

Now we are ready to export the file. You can export the file as a DesignSpark Mechanical-

compatible-IDF file, or a normal IDF file. Here we will export the file for DesignSpark 

Mechanical. Select “Output” from the top menu and then click DesignSpark (IDF), and 

then a window will show up, as shown in Fig. 3-52. 
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Fig. 3-52 Exporting the 3D file as IDF format 

 

In Fig. 3-52, the output filename is the name you want to save the file as. For board 

thickness, we set it as 1.6mm. Once you hit OK, two files will be saved, where one is 

an .idb file, and the other one is an .idl file. The IDB file is the actual design file, and the 

IDL stores the information of the component. Now you can open the IDB file with 

DesignSpark Mechanical, as shown in Fig. 3-53. A folder will be created by DesignSpark 

Mechanical automatically. 
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Fig. 3-53 Opening the 3D file in DesignSpark Mechanical 

 

3-5-2 Importing DXF file 

 

Besides exporting the 3D file, you can also import a 3D file for reference. Here we use a 

case from RS Components as an example. Most of the components from RS Components’ 

website have a 3D file available. You will need to register as a member first, which is free, 

before you can download the 3D files. In the website, please search for RS part number 

7739461, which is a plastic case named “BOCUBE IP67 enclosure”, as shown in Fig. 3-

54. 
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Fig. 3-54 Searching for RS part 7739461 

 

Once you found the part, download the CAD file as an AutoCAD DXF format. You can 

use DesignSpark Mechanical to preview the file, as shown in Fig. 3-55. 

 

 

Fig. 3-55 The downloaded 3D DXF file 

 

Then, go back to DesignSpark PCB and click “Import…” from “Files”, choose the file you 

downloaded, and then a window will show up, as shown in 3-56. 
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Fig. 3-56 Importing DXF file 

 

In the window, make sure you check the unit as metric, and set the import type as board. 

Once you press OK, the design file will show in the main window, as shown in Fig. 3-57. 
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Fig. 3-57 The imported design file 

 

Now you can design your PCB based on the dimension of the case. For example, you can 

make mounting holes that match to the position of the case, as shown in Fig 3-58. 

 

 

Fig. 3-58 Making mounting holes that match to the design of the case 
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3-6 Summary 

 

In this chapter, we introduced the basic concepts of a PCB, starting from materials, 

structure, to properties. For PCB design, DesignSpark provides an easy and straightforward 

way for us to transfer the schematic into PCB layout. DesignSpark also provides several 

powerful tools for routing inspection and debugging. Being able to export and import CAD 

files is also a nice feature for us to work with other CAD software. Once you are familiar 

with all the topics covered in this chapter, you will be able to create a PCB on your own. 

In the next chapter, we will show you how to use DesignSpark to generate a bill of materials, 

and talk about sending your design to get a quote for manufacturing.   
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Chapter 4 – Make a Circuit Board 

 

4-1 Manufacturing Plots 

 

After the PCB design is done, we can further use this file. Firstly, we will introduce how 

to generate Manufacturing Plots. Manufacturing plot is the final design we give to the 

manufacturers, and they will make circuit boards according to this design. DesignSpark 

supports Gerber and Excellon NC drill file formats in which Gerber files are the standard 

format used to describe each PCB laminate, including silkscreen, solder resist layer, wiring 

layer, etc. PCB Gerber files are a must to make the film, and the Excellon file is for CNC 

machine routing and drilling functions. These two files must be sent to the manufacturer. 

 

To establish a manufacturing design, please click on Output on the toolbar and find the 

Manufacturing Plots, shown in Fig. 4-1. 
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Fig. 4-1 Generate a manufacturing plot 

 

And a manufacturing plot design window will pop up like Fig. 4-2. 

 

 

Fig. 4-2 Manufacturing plot design window 

     

As shown in Fig. 4-2, the window can be divided into three regions, in the drawing area, 

we can choose a drawing and graphics output option; in the output area, you can select the 

output type, stack, drawing content and proportion; and in the drawing-generating area, 

you can choose to automatically generate graphics, add or remove graphics, and alignment 

of the drawing. While setting, check the Plot Preview allows you to preview the output of 

the design shown in Fig. 4-3. 
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Fig. 4-3 Plot preview 

     

After setting the drawing parameters, you are ready to output a design. Before output, you 

can click on Options in the bottom-right corner to set the output path of the file, shown in 

Fig. 4-4. 

 

Fig. 4-4 Output settings 

     

The default position of the output file is the same directory as the design file, if you want 

to change the location, please choose Always To This Directory, and click Browse to 
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specify the path. 

 

After finishing setting output options, click OK and return to the main screen, press Run in 

the bottom-right corner of the screen, and the image files you checked in the drawing area 

will be outputted. 

 

4-2 Bill of Materials 

 

Establish BOM (Bill of Materials, hereinafter referred to as BOM) is a practical feature of 

DesignSpark, it can be connected directly to the RS-Online e-commerce website for real 

time prices and availability directly from your local RS website. Produced quotations can 

also be downloaded, saved or forwarded to other people, simplifying the manufacturing 

process of a PCB. 

 

To generate BOM, click the BOM Quote in top-right corner of the screen, shown in Fig. 4-

5. 

 

 

Fig. 4-5 Generate BOM quote 
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After selecting BOM Quote, all the parts in the design will be shown in a new window. 

Click on the transfer button in the new window to pass the BOM list from the DesignSpark 

website to RS Component’s shopping basket (the browser will automatically open, 

remember to keep your computer on the network). You can also download the BOM by 

clicking on the save icon, shown in Fig. 4-6. 

 

 

Fig. 4-6 Transfer to RS shopping basket (left) export BOM (right) 

 

4-3 PCB Real-time Quotes 

 

After processing the parts, the last tasks are PCB quote and manufacture; both are at the 
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upper-right corner of the main screen. Please click the PCB Quote, a window will pop up 

for you to confirm the design. Since we completed debugging, and also confirmed the 

design details, we can directly click Quote shown in Fig. 4-7. 

 

 

Fig. 4-7 Confirm the design is completed or not before quote 

 

4-4 Summary 

 

Our introduction to DesignSpark PCB has come to an end, from circuit diagram design, 

PCB design and manufacturing to the valuation, you now have the ability to complete your 

board on your own! In the next chapter, we will introduce DesignSpark Mechanical, this is 

a very powerful 3D modeling software can let you create various 3D models. 
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